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1Welcome to 
mySewnet™ Configure

Use mySewnet™ Configure to adjust the settings for displaying and 
exporting your embroidery files, and to register your mySewnet™ 
Embroidery Software.

To get started with mySewnet™ Configure , open it and select the feature that 
you want to adjust.

The mySewnet™ Configure setup utility allows you to adjust settings for displaying 
and exporting your embroidery files. It also contains system utilities for registering 
your mySewnet™ Embroidery Software. Adjust the settings on each tab of 
mySewnet™ Configure.

Use Reset All Apps  if you wish to reset the toolbars and control panels exactly 
as they were when the software was installed. All Preferences settings will be 
restored to their initial values. Reset All Apps does not affect the settings in 
mySewnet™ Configure.

Reference Guide
The Reference Guide shows how to start the app and provides a quick tour of the 
main screen. The Reference Guide is supplied in PDF format , ready for printing, 
and contains full reference information.

Help
The integrated help contains full reference information. Click the Help button . 
Where available, a help topic appears that is relevant to the selected item. 
Alternatively, use the Help menu.

Viewing and Printing PDF Guides
To find all the Reference Guides for your mySewnet™ Embroidery Software, go 
to the mySewnet™ Guides page, linked to from download.mysewnet.com. Select 
the desired PDF guide.

Note: To view and print the PDF Guides, you may use Preview which is included in 
your Mac OS®.

Readme
The most up-to-date details about the mySewnet™ Embroidery Software are in 
the Readme.rtf file available when you install your mySewnet™ Embroidery 
Software.
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Sample Files
Samples are provided for your use. Download the sample files from the 
Downloads page: download.mysewnet.com. Copy the samples folder to the folder 
of your choice. 

Note: For the exercises in this manual, the mySewnet folder is used.

About mySewnet™ Configure
Access via the mySewnet™ Configure menu. The version number of mySewnet™ 
Configure is given here. You will need this if you contact technical support at any 
time.

Starting mySewnet™ Configure

■ Click the mySewnet™ Configure icon  in the Launchpad.
■ Double-click the mySewnet™ Configure icon  in the Finder.

Quit mySewnet™ Configure
■ Choose mySewnet™ Configure > Quit mySewnet™ Configure.
■ Use the red close button  at the top left. 
■ Press ⌘Q
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2Utilities

Use the Utilities tab to start the system utilities.

The utilities are:

■ Thread Cache 
Use mySewnet™ Thread Cache to list your personal thread collection, to create a 
list of favorite thread ranges, and to view your threads on your mobile device at 
the Thread Cache website. See the mySewnet™ Thread Cache Reference Guide 
or Help for more information.

■ Quick Font 
Use mySewnet™ QuickFont to create fonts automatically for use with your 
mySewnet™ Embroidery Software, or your embroidery machine. See the 
mySewnet™ Embroidery Reference Guide or Help for more information.

■ Start mySewnet™ Connect 
Start up communications with mySewnet™. For more information, see the section 
on ***Sending in the mySewnet™ Embroidery Reference Guide and Help.

■ Check for Updates 
With the click of a button, you can check to see if any updates have been released. 
See “Updating Your Software” on page 4.

■ Reset All Apps 
If desired, in any app you may change the toolbar using View > Customize Toolbar. 
Use Reset All Apps in mySewnet™ Configure if you wish to reset the toolbar, 
window positions and so on, exactly as they were when the software was installed. 
All Preferences settings are restored to their initial values.
Note: The settings in mySewnet™ Configure for displaying embroidery files are not 
affected by the Reset All Apps function. See “Reset All Apps” on page 4.
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■ Reset File Association 
Reset the file associations for embroidery files and embroidery design files. See 
“Reset File Associations” on page 6.
Note: This may be required if other embroidery software is installed after the 
mySewnet™ Embroidery Software.

■ Backup My Settings 
Use Backup My Settings to save your My Thread databases, including custom 
threads and My Thread Ranges, My Motifs and My Fills. See “Backup My Settings” 
on page 4.

■ Restore My Settings 
Use Restore My Settings to restore the My Settings previously saved by Backup My 
Settings. See “Restore My Settings” on page 5.

Updating Your Software
With the click of a button, you can run the Check for Updates  utility to see if 
any new fonts, thread ranges or any other updates have been released. 

1 Close any mySewnet™ Embroidery Software apps that may be open.
2 Open mySewnet™ Configure from the Launchpad  or Finder .
3 Click Check for Updates .
4 The updates will be downloaded and installed.

Reset All Apps
If desired, in any app you may change the toolbar using View > Customize Toolbar. 
Use Reset All Apps  if you wish to reset the toolbar, window positions and so 
on, exactly as it was when the software was installed. All Preferences settings are 
restored to their initial values.

Note: The settings in mySewnet™ Configure for displaying embroidery files and 
exporting your embroidery files are not affected by the Reset All Apps function.

Backup My Settings
Use Backup My Settings  to save the following:

• My Thread databases, including custom threads
• My Thread Ranges list
• My Motifs
• My Fills

You may wish to do this, for example, when you are moving to a new computer.
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Backing Up Your Settings
1 Click Backup My Settings  and a Save dialog appears. 
2 In the dialog the default name for the backup file is 'mySewnet1_MySettings.zip'. If desired, 

change the name. For example, include the backup date in the name.
3 Click Save to save the backup file in the default /mySewnet/System Backup folder. 

Alternatively, browse to a different folder to save the backup file. 
A message will appear when the backup has completed successfully.

4 If desired, create a copy of the backup on media such as a USB memory stick or Cloud 
storage.

Backing Up Fonts and Backgrounds
Note: Do not copy system fonts or backgrounds provided with your mySewnet™ 
Embroidery Software as this may affect the update process.

To backup fonts created with the QuickFont Assistant in mySewnet™ 
Embroidery, copy them from the My Fonts folder.

Backup Your My Fonts Folder
1 Open Finder.
2 In the Go menu, hold down the Option key and choose Library.
3 Choose /[User]/Library/ApplicationSupport/mySewnet/Embroidery1/Fonts
4 Copy the My Fonts folder to backup media such as a USB memory stick or Cloud storage.

Backup your Backgrounds
■ To backup backgrounds created with the Background Assistant in mySewnet™ 

Embroidery, copy them from the subfolders of /mySewnet/Backgrounds/. The main 
folders for backgrounds you create should be 

• Backgrounds/Garments/My Garments
• Backgrounds/QuiltBlocks/My QuiltBlocks

Restore My Settings
Use Restore My Settings  to restore the My Settings previously saved by Backup 
My Settings.

Restoring Your Settings
1 Click Restore My Settings and an Open dialog appears showing the System Backup folder. 
2 If needed, browse to the location of the My Settings backup file.
3 Click the backup file then click Open. 

A confirmation message appears, indicating that this will overwrite the current My Settings. 
4 Click OK and the My Settings are restored.
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Reset File Associations
Use Reset File Associations  to reset the file associations for embroidery files 
and embroidery design files.

Note: This may be required if other embroidery software is installed after the 
mySewnet™ Embroidery Software.

Resetting File Associations
1 In the Utilities tab of mySewnet™ Configure, click Reset File Associations .
2 Select (check) the file types that you want to associate with your mySewnet™ Embroidery 

Software.
3 Click OK to reset the file associations for those file types.

If you click one of these file types to open it, it should now be opened by your mySewnet™ 
Embroidery Software.

Add Your mySewnet™ Embroidery Software Apps to the Dock
1 Click the mySewnet™ Embroidery icon in the Launchpad  or Finder  to start 

mySewnet™ Embroidery.
2 Control–click the mySewnet™ Embroidery icon in the 

Dock.
3 Choose Options > Keep in Dock. You can now open 

mySewnet™ Embroidery at any time from the Dock.
4 Click the mySewnet™ Thread Cache icon in the 

Launchpad  or Finder  to start mySewnet™ Thread 
Cache.

5 Control–click the mySewnet™ Thread Cache icon in the 
Dock and choose Options > Keep in Dock.

6 Click the mySewnet™ Configure icon in the Launchpad  or Finder  to start 
mySewnet™ Configure, then Control–click the mySewnet™ Configure icon in the Dock 
and choose Options > Keep in Dock. (If TruEmbroidery™ 3 Elements or Premier+™ 
EXTRA are owned, all of your mySewnet™ Embroidery Software apps can now be easily 
accessed from the Dock.)
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Note: If you only own mySewnet™ Connect, open mySewnet™ QuickFont in the 
Launchpad  or Finder , then Control–click the mySewnet™ QuickFont icon in the 
Dock and choose Options > Keep in Dock. (If other mySewnet™ or Premier+™ software 
is owned, you can use the QuickFont Assistant button in the Configure Utilities tab, or in 
the Letter window in Embroidery.)

7 If available, click the mySewnet™ Digitizing icon in the Launchpad  or Finder  to start 
mySewnet™ Digitizing, then Control–click the mySewnet™ Digitizing icon in the Dock and 
choose Options > Keep in Dock.

8 If available, click the mySewnet™ Stitch Editor icon in the Launchpad  or Finder  to 
start mySewnet™ Stitch Editor, then Control–click the mySewnet™ Stitch Editor icon in 
the Dock and choose Options > Keep in Dock.

9 If available, click the mySewnet™ Cross Stitcher icon in the Launchpad  or Finder  to 
start mySewnet™ Cross Stitcher, then Control–click the mySewnet™ Cross Stitcher icon 
in the Dock and choose Options > Keep in Dock. (If your subscription covers the full 
system, all of your mySewnet™ Embroidery Software apps can now be easily accessed from 
the Dock.)
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3Your mySewnet™ Account

Use the mySewnet tab to manage access to your mySewnet™ 
account.

mySewnet
Use the mySewnet tab to connect to your mySewnet™ account and to set a name 
for your computer for your mySewnet™ account.

mySewnet™ Account
Enter an email address and password to connect to your mySewnet™ account.

Note: Once signed in, you remain signed in (even between sessions) until you sign 
out.

Register if you don’t have a mySewnet™ Account
Use this option to set up a mySewnet™ Account.

Reset your password if you’ve forgotten it
Use this option to reset the password for your mySewnet™ Account.

Manage my Account
View and update your account on the mySewnet™ website.

My Computer
Manage the mySewnet™ activation on the current computer.

Sign in to your mySewnet™ account

Update your subscription information

Activate or deactivate on this computer 

Enter your email address
Sign out from your mySewnet™ account

Register for a mySewnet™ account

Change the password for your account

Set a Computer Name for your account
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Identify this computer as
Set a name for your computer in your mySewnet™ Account. For example, set 
different names for your laptop and desktop computers.

Note: Initially, the name of your Mac is displayed.

Status
Manage the mySewnet™ activation on this computer.

Note: Use Deactivate to reclaim the activation on the current computer.

Manage my Activations
Use Manage my Activations to view your current activations, and deactivate any 
that are no longer wanted.

Send Anonymous Data
All data sent to the mySewnet™ server is sent anonymously when this is checked.

Note: This is checked by default.
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4Appearance Options

Use the Appearance settings to vary the way embroidery files are displayed in your 
mySewnet™ Embroidery Software.

Background Color
Set the background color for mySewnet™ Embroidery Software to whatever you 
prefer. Click the Color block and the Colors window appears to allow you to 
choose a color. The color set by default for your mySewnet™ Embroidery 
Software is 211, 233, 255 (RGB).

Note: When you click on a color, the Background Color will change immediately. 
You will see the effect in any mySewnet™ Embroidery Software apps that are 
open. When you are happy with the color, close mySewnet™ Configure.

Colored PencilsSelect a color model

Click to select a color

Drag the selected color 
to the palette
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Background Texture
Select the texture that is used in your mySewnet™ Embroidery Software. 

■ Choose the desired fabric type from the pop-up menu, or select None to have no 
texture.

Grid Color
Set the grid color for your mySewnet™ Embroidery Software to whatever you 
prefer. Click the Color block and the Colors window appears to allow you to 
choose a color. The color set by default for your mySewnet™ Embroidery 
Software is 127, 127, 127 (RGB).

Real Size
Use the on-screen ruler to adjust the settings so that your mySewnet™ 
Embroidery Software can display embroideries at their real-world size. 

Note: The real size measurement is 100% on the Zoom Slider.

Change the Measurement for Real Size
1 Hold a ruler against the screen and measure the number of millimeters that correspond to 

the length of the on-screen ruler. 
2 Enter this number in the box, or use the arrows to change the number. 

Note: You will see the effect on the Zoom Percentage in any mySewnet™ Embroidery 
Software apps that are open.

3 When you are happy with the measurement, close mySewnet™ Configure.

Show Measurements In
Choose between Millimeters and Inches for entering and viewing measurements in 
your mySewnet™ Embroidery Software. The alternative units will be shown when 
you hover the pointer over a measurement.

Note: When Inches is selected, the underlying dimensions are still in Millimeters 
and the nearest equivalent Stitch Lengths are shown in inches.

The default measurements for your mySewnet™ Embroidery Software are 
Millimeters.

Cut-out Appliqué Background Color
Set the appliqué background color for mySewnet™ Embroidery Software to 
whatever you prefer. Click the Color block and the Colors window appears to 
allow you to choose a color. The color set by default for your mySewnet™ 
Embroidery Software is 142, 178, 212 (RGB).

Texture
Select the texture that is used for a cut-out appliqué background (for cut holes) in 
your mySewnet™ Embroidery Software. 

■ Choose the desired fabric type from the pop-up menu, or select None to have no 
texture.
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5Import and Export

Use the Import options to choose a thread range, and the Export 
options to configure the way your embroidery files are saved and 
stitched out.

Import
Use the Import tab to choose a thread range for your mySewnet™ Embroidery 
Software.

Import Thread Range
Select the palette that is active when loading embroidery files in your mySewnet™ 
Embroidery Software unless their colors have already been set from another 
Thread Range. Choose from the following Thread Manufacturers: Robison-Anton 
Rayon 40, Anchor-Alcazar Rayon 40, Icord Poly 40, Isafil Rayon 40, Madeira Poly 
Neon 40, Madeira Rayon 40, Robison-Anton Poly 40, Sulky Poly Stickma 40, Sulky 
Rayon 40. 

■ Choose a thread range from the pop-up menu.

Export
Use the Export tab to vary the way embroidery files are saved and stitched out in 
your mySewnet™ Embroidery Software.

Note: Change the file format, if desired, in the Export dialog of each mySewnet™ 
Embroidery Software app.

Optimize for Sewing Options
All of these options are initially selected when saving as a combined .vp3 file, or in 
any other format.

Note: You can customize the Optimize for Sewing Options when exporting in any 
mySewnet™ Embroidery Software app.

Create placement stitches for Decorations,

Rotate the embroidery to fit the hoop 

Settings for splitting with Multipart Hoops
Set the suffix to add to an exported file name

Route split line to minimize cut stitches
Use a straight line
Add an alignment cross at the end of 

Select the Optimize for Sewing settings

or remove decorations

orientation, or flip it for stitching in reverse 

each section
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Combine: Merge the embroideries into a single embroidery during Export.

Note: Combine is not enabled if there is only one design, and for embroidery 
formats that are automatically combined.

Remove Overlap: Prevent areas of stitches building up where embroideries 
overlap.

Remove Overlap is not available when Combine is not enabled.

Note: Only deselect this option if, for example, your embroideries are low density 
and you wish to have a blend effect where they overlap.

ColorSort: Reduce the number of thread colors during Export.

Optimize Stitch Length: Automatically remove small and insignificant stitches. 
See “Optimize Stitch Length” on page 16.

Note: Cutwork Needle lines in the Inspira Cutwork Needle "thread range" are 
unaffected by Optimize Stitch Length.

Decoration
Create Center or Line placement stitches for Decorations added in mySewnet™ 
Embroidery Extra, or remove all decorations and their associated placement 
stitches.

Center or Line Placement
Center or Line marker stitches are created automatically for decorations 
according to the options set here. The settings may be altered when you export 
the embroidery.

• Center placement stitches are recommended when most decorations are 
individual and symmetrical. 

• Line placement stitches are recommended when most decorations are individual 
and asymmetrical (such as bugle beads) or lines of closely spaced beads or 
sequins.

Create as Center Markers: Create a small cross shape in stitches to show 
where the decoration is to be placed.

Create Line Markers: Create a single stitch that runs along the length of the 
decoration.

Remove All Decorations: Remove all decorations and marker stitches from the 
exported version. This may be desired to create an embroidery with a 
complementary crystal transfer template (made using the Export Decoration 
Template dialog in mySewnet™ Embroidery). 

Hoop Orientation
Set the hoop orientation.
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Rotate to fit natural hoop position: Rotate the embroidery if needed to fit 
with the default hoop orientation for the machine. This option is only available if 
the hoop on the main screen is in the rotated orientation. It is useful if you prefer 
to create a "landscape" shaped project in the rotated orientation.

Automatically flip if Felting Needle detected: Flip the embroidery for 
stitching in reverse. If an embroidery contains a Felting Needle color effect this 
option is selected initially. 

Export File Name
When a file is exported, a suffix is added to the file name of the exported version 
to distinguish it from the original multipart embroidery file. 

■ Use Export File Name to change the text used for the suffix. The initial text is 
"Exported".

Splitting for Multipart Hoops
Embroideries for Multipart hoops are split automatically, according to your Export 
settings. Use an Intelligent or Straight Line Split.

Note: There is no need to ensure embroideries are in one stitch area of the hoop; 
just place your embroideries in the most pleasing arrangement. 

Split Method
You can use one of two split methods:

• Intelligent Split automatically calculates a split line that cuts the minimum 
number of stitches, and minimizes cuts through solid sections of embroidery. 
Where possible, use Intelligent Split.

• Straight Line Split cuts the embroidery straight across the center line of the 
overlap zone.

Intelligent with Tolerance
Intelligent Split calculates a split line that cuts the minimum number of stitches, and 
minimizes cuts through solid sections of embroidery. For example, a large 
embroidery is split at a narrow section, and an embroidery that fits in one stitch 
area of the hoop is left in one piece even if it is part of a larger design.

Tolerance ensures that the Intelligent Split line stays a short distance from the 
edges of the overlap. This allows for play in the hoop when going from one hoop 
area to another, such as when aligning a hoop that has been turned to stitch out 
the other side of an embroidery.

You can set Tolerance from 0 to 3mm, in steps of 1mm. The initial setting is 1mm.

Use Intelligent Split with Tolerance
■ Select the "Intelligent with Tolerance" checkbox, then enter a number in the 

Tolerance number box, or use the arrows to increase or decrease the Tolerance.
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Straight with Compensation
Straight Line Split cuts straight across the center of the overlap zone. Straight Line 
Split will only split an individual embroidery if, before it is combined with 
everything else, it does not fit entirely into one stitch area of the hoop.

Note: Lettering is split straight down the middle, as with any other type of 
embroidery. This may cut through characters rather than gaps and spaces. In such 
cases, it is recommended to use Intelligent Split instead.

Compensation adds overlapping stitches along the edges where the embroidery 
is split. This compensates for pull on the fabric.

Alignment Stitch for Turnable Hoops
Select this option to add an alignment cross at the end of the first embroidery 
section when using the HUSQVARNA VIKING® Designer Majestic™, PFAFF® 
creative Grand Dream™, Universal Multipart hoop or Brother Jumbo Frame. A 
hoop movement to the alignment cross is added at the beginning of the next 
section. The next embroidery section can then be correctly aligned, or alignment 
can be confirmed.

None Use None if you can split an embroidery without cutting through any of the 
design elements. Compensation is initially set to None.

Low Use Low when cutting through a lightly stitched embroidery or when the split 
lines go through only a few stitch areas.

High Use High when the embroidery is dense, when the split lines make long splits 
through stitch areas, or when stitching onto materials such as knitted or 
stretchy fabric.
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Optimize Stitch Length
Use Optimize Stitch Length to automatically remove small and insignificant 
stitches.

Stitch Length Sensitivity
Adjust the sensitivity of the optimization. Low is set as the default.

■ Choose Low, Medium or High from the pop-up menu.

Minimum Significant Stitch Length
Select the shortest stitch length that you consider to be significant. Stitches below 
this length are removed during the optimization process. The default stitch length 
is 0.8 mm.

Note: Cutwork Needle lines are unaffected by the Minimum Significant Stitch 
Length.

Choose 0.6 mm, 0.8 mm or 1.0 mm from the pop-up menu.

Adjust the sensitivity
Set your shortest desired stitch length
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6Sending Embroideries

Send designs to and from your mySewnet™ enabled embroidery 
machine, and use mySewnet™ Connect to change your mySewnet™ 
settings.

Send designs to your mySewnet™ enabled embroidery machine via mySewnet™ 
from within the mySewnet™ Embroidery Software, or directly from your 
mySewnet™ account.

Use mySewnet™ Connect to change your mySewnet™ settings.

Sending via mySewnet™
Send is available in mySewnet™ Embroidery, mySewnet™ Stitch Editor, 
mySewnet™ Cross Stitcher and mySewnet™ Digitizing. 

Sending from a Machine to mySewnet™ Embroidery
You can send an embroidery from a mySewnet™ enabled embroidery machine to 
mySewnet™ Embroidery on your computer. Adjust the embroidery, then return it 
to your machine for stitching.

To be able to send from your machine to mySewnet™ Embroidery, and to send to 
your machine from mySewnet™:

■ mySewnet™ Connect must be running on the computer
■ You must use a mySewnet™ enabled embroidery machine with the most recent 

updates installed
■ The computer and embroidery machine must be signed in to the same 

mySewnet™ account.

Note: An embroidery moved from a machine to mySewnet™ Embroidery will 
include no special features from the embroidery machine, for example changing 
the words for lettering. This is also true of designs sent in the other direction.

Send from an Embroidery Machine
1 Go to the embroidery machine.
2 Tap the Cloud button at the top and ensure that you are signed in to mySewnet™.
3 Select embroidery mode, and then load an embroidery.
4 In the machine screen, choose the send to software option. 
5 Select the computer to send to, then send the embroidery. 

The embroidery will open in a new mySewnet™ Embroidery window.
6 When you have adjusted the embroidery, save the changes to your computer.

Note: You can name your computer in the mySewnet tab of mySewnet™ Configure. See 
“mySewnet” on page 8.
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You can then use Send Express to mySewnet™ Device to return the edited 
embroidery to your machine for stitching out. See “Send” on page 26.

Note: When you send from your embroidery machine to mySewnet™ Embroidery, the 
embroidery may be sent to a window beneath the active maximized window. The 
mySewnet™ button in the taskbar flashes to indicate that a design has been sent.

mySewnet™ Connect
Use mySewnet™ Connect to change your mySewnet™ settings in mySewnet™ 
Configure.

Use the mySewnet™ Connect menu to check the status of your mySewnet™ 
connection.

The System Tray Icon
When the mySewnet™ Connect app is running, there is an icon in the menu 
bar  at the top right of your computer screen. The icon shows whether there is 
communication with your machine:

■ Click the icon to see the mySewnet™ Connect Menu.

Note: To change your mySewnet™ settings, see “mySewnet” on page 8.

Use the file manager on your machine to browse your computer and copy 
embroideries to any folder on your machine.

Starting mySewnet™ Connect
mySewnet™ Connect is set to start automatically when you restart your 
computer. If it is not open, use the following steps.

1 Open mySewnet™ Configure .
2 On the Utilities tab, click Start mySewnet™ Connect . The mySewnet™ Connect 

icon  can now be seen in the menu bar.
3 To close mySewnet™ Connect, click the icon in the menu bar and in the mySewnet™ 

Connect menu click Quit.

mySewnet™ Connect Menu
Click the mySewnet™ Connect icon on the menu bar to 
see a menu of options.

The menu tells you whether you are signed in to 
mySewnet™.

Note: For mySewnet™ the current status in mySewnet™ 
Configure is listed. If you have more than one machine, 
the first found is used.

Communication established No communication
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■ Choose About mySewnet™ Connect to see the version number and copyright.
Note: You will need this version number if you contact technical support at any 
time.

■ Select Start Automatically to select or deselect the automatic start when the 
computer starts.

■ Select mySewnet™ Options to view the mySewnet tab in mySewnet™ Configure. 
See “mySewnet” on page 8.

■ Select Help to display help pages about mySewnet™ Connect.
■ Select Exit to close mySewnet™ Connect and remove it from the menu bar.



20          mySewnet™ Configure   Finder Integration & Spotlight 

7Finder Integration & Spotlight

Use Finder and Spotlight to view your embroideries and their details.

When mySewnet™ Embroidery Software is installed, it is integrated with the 
Finder so that embroidery files can be viewed as icons, and the Spotlight search 
feature can be used on embroideries, and embroidery details.

• Open embroidery designs in mySewnet™ Embroidery or mySewnet™ Stitch 
Editor.

• Open design outline files (.edo) in mySewnet™ Digitizing.
• Open cross stitch design files (.krz) in mySewnet™ Cross Stitcher.

Note: Embroidery design outline (.edo) files appear in the Finder with a colored 
representation of the filled areas.

Note: Melco (.exp) embroidery files cannot be seen in the Finder. Use Insert to 
open them.

View Embroideries in the Finder
1 Click the Finder icon  in the Dock 

to open it.
2 In the Finder, choose Go > Home, or 

press ⇧⌘H.
3 In the Show items pop-up menu, 

choose Columns view .
4 Browse to mySewnet/Samples/

Embroidery/Stitch.
5 In the Show items pop-up menu, 

choose Icons . 

To learn how to Go to

View the details for an embroidery in the Finder. See “View Embroideries in the Finder” 
on page 20.

View the design information in the Quick Look 
window for the file.

See “Quick Look” on page 24.

Search for embroidery designs using Spotlight. See “Searching for Embroideries” on 
page 33.

Create a copy of the selected embroideries in 
another embroidery file format, with a different 
thread range, or with added trims or notes.

See “Convert” on page 27.

Send the selected embroidery to the 
mySewnet™ cloud for your mySewnet™ 
enabled embroidery machine.

See “Send” on page 26.
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You can now see the .vp4 embroidery files in the folder as thumbnail pictures.
6 Choose Column view  again, 

and click Biplane. The vintage 
plane design is shown on the 
right.

7 In the Show items pop-up menu, 
choose Gallery view  (the 
fourth option). Click on the 
biplane design. You can now 
swipe to view the other designs.

8 Return to Icon view .
9 Select Grapes and Birds.vp4.
10 Control–click and choose Quick 

Look.

The embroidery worksheet appears, showing a picture of the embroidery, the color blocks 
used, the stitch count, the number of colors, the dimensions, and the Notes.

11 Control–click Grapes and Birds.vp4 again and choose Get Info.
Some information on the embroidery appears, including the date 
modified, number of colors, stitches, the dimensions and Notes.
Note: From the Open With option on the pop-up menu you can choose 
to open the embroidery in mySewnet™ Embroidery or mySewnet™ 
Stitch Editor. You can also choose Open With from the Quick Look or 
Get Info windows. 
If desired, use the Get Info window to choose an application to open all 
embroidery files (for example, mySewnet™ Stitch Editor), so that when 
you double-click on a file it opens in your chosen application.

12 Open the Preview. A picture of the design appears.
13 Control–click Grapes and Birds.vp4 again and choose Services.
14 Use mySewnet™ Send to send the embroidery to your computer, or to 

your mySewnet™ enabled embroidery machine.
15 Use mySewnet™ Print to print the worksheet for the embroidery, 

using the settings selected in mySewnet™ Embroidery.



22          mySewnet™ Configure   Finder Integration & Spotlight 

16 Use mySewnet™ Convert to create a copy of the embroidery in 
another embroidery format, with a different thread range, or 
with added trims or notes.
Note: mySewnet™ Connect only owners may only convert to 
.vp3 or .vp4.

17 Close the Grapes and Birds.vp4 Info window, then click Column 
view .

18 Browse to /mySewnet/Samples/. This folder contains pictures 
and embroidery files.

19 In the Spotlight  text box, enter a keyword to search, for 
example, "Rose".

20 Click Icon view .
21 The search has been made on the whole computer, and any file with the word "rose" in it is 

listed. In Search, select "Samples".
You can now see thumbnail pictures for embroidery (.vp4 and .edo) and picture (.jpg) files.

22 To the right of the window, click +. A second search bar appears.
23 In the pop-up menu on the left, choose Kind, and in the pop-up menu on the right choose 

Other. Then enter "embroidery" in the text box. Only embroidery files are now displayed.
Note: If you had performed this search on the whole of your computer, all embroidery files 
on your Mac would be listed.

24 Click the pop-up menu on the left and choose Other. A list of attributes to search on 
appears.
You can choose embroidery features, for example number of colors, in these pop-up 
menus.

25 Scroll down to "Embroidery" to see the 
details you can search for.

26 Click Cancel.
You can construct very complex searches 
using these features.

27 To the right of the window, click Save.
28 Give your search a name and save it. Use 

this feature to save a search for 
embroideries to the sidebar, for easy 
access.

29 To the right of the window, click +. A third 
search bar appears. You can use this to check for last used time.

30 Close the Finder window to finish searching.

Finder Plugin Options
The following options are available from the context menu.

Open
Open the selected embroidery in the default mySewnet™ Embroidery Software 
app.

■ Control–click an embroidery and choose Open.
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Open With
Choose an app to open the selected embroidery(ies) from the context menu. The 
default mySewnet™ Embroidery Software app is at the top of the list.

Note: Use Get Info to change the default app for opening embroideries.

■ Control–click an embroidery and choose Open With, then choose an app from 
the context menu.

Get Info
View information on the selected embroidery(ies), or open them in the selected 
mySewnet™ Embroidery Software app. See “Get Info” on page 25.

■ Control–click an embroidery and choose Get Info.

Quick Look
View full information for the selected embroidery. See “Quick Look” on page 24.

■ Control–click an embroidery and choose Quick Look.

Services

mySewnet™ Convert
Create a copy of the selected embroideries in another embroidery file format, 
with a different thread range, or with added trims or notes. See “Convert” on 
page 27.

■ Control–click an embroidery and choose Services > mySewnet™ Convert.

mySewnet™ Print
Print a worksheet for the selected embroidery(ies), according to the selected 
printer in System Preferences, and options set in mySewnet™ Embroidery.

■ Control–click an embroidery and choose Services > mySewnet™ Print.

mySewnet™ Send
Use mySewnet™ Send to send embroideries to the Cloud, your computer, or 
directly to the embroidery machine screen of some HUSQVARNA VIKING® or 
PFAFF® machines. See “Sending Embroideries” on page 17.

• Use mySewnet™ Send to send the selected embroidery, or embroideries, to the 
mySewnet™ cloud for your mySewnet™ enabled embroidery machine, or to 
your mySewnet™ enabled embroidery machine via the mySewnet™ cloud. See 
“Send” on page 26.

■ Control–click an embroidery and choose Services > mySewnet™ Send.
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Quick Look
View full details about an embroidery in its 
Quick Look worksheet, including the 
thread name and shade, the design 
information, and the Notes and Technical 
information.

Open With
Open the selected embroidery in the app 
mentioned on the button at the top right.

Note: Change the default app for opening 
embroideries in Get Info. See “Get Info” on 
page 25.

Design Information
The dimensions (Height and Width), Stitch 
Count, and number of colors for the 
selected embroidery are shown in the 
Design Information.

Color Information
A table shows the thread colors and thread ranges used in the selected 
embroidery, and the stitch count for each color.

Note: You may need to use the horizontal scroll bar to see all the color 
information in the table.

Notes and Technical Information
View any notes included with the embroidery, and its position relative to the 
center of the hoop.

Use Quick Look to View an Embroidery
1 Select the embroidery that you want to view.
2 Control–click it and in the context menu select Quick Look. The Quick Look window 

opens.
The design information, thread colors, notes, and technical information for the embroidery 
is shown.

3 Click the Open with... button at the top right to open the embroidery in the selected app.
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Get Info
View details about an embroidery in its Get Info 
window, including the name, date modified, number of 
colors, stitches, the dimensions and Notes.

Use the Get Info window to change the default app for 
opening the selected embroidery, or for all embroideries 
of that type.

Note: If multiple embroideries are selected, a Get Info 
window is opened for each embroidery.

General: The General information includes the name, 
file type, file size, address, and date of creation and 
modification.

More Info: The More Info section includes the number 
of stitches, colors, dimensions, and Notes and Settings.

Open With
Use Open With to change the default app for opening 
the selected embroidery when it is double-clicked. To 
open all embroidery files of this type with that app, use 
Change All.

■ Choose an app in the Open With pop-up menu (for example, mySewnet™ Stitch 
Editor) to always open the selected .vp4 embroidery in the chosen app when the 
file is double-clicked. Click the Change All button to open all .vp4 files in that app 
when double-clicked.
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Send
Use the Send dialog to send the selected embroidery to the mySewnet™ cloud for 
your mySewnet™ enabled embroidery machine, or to your mySewnet™ enabled 
embroidery machine via the mySewnet™ cloud.

Note: The settings in the Export window are used when sending to mySewnet™. 
See “Export” on page 12.

Send an Embroidery to mySewnet™
1 In Finder, Control–click an embroidery.

Note: You can send any supported embroidery file format.
2 In the context menu, choose Services > mySewnet™ Send.
3 In the Send to mySewnet™ dialog select Send to mySewnet™ Cloud to send the 

embroidery to your mySewnet™ cloud storage.
4 To send the embroidery via WiFi to your mySewnet™ enabled embroidery machine or 

computer, select Send Express to mySewnet™ Device, then click the machine’s or 
computer’s name in the Devices section.
Note: Set the machine’s nickname on the machine itself.
Connect to your mySewnet™ account in the mySewnet tab of mySewnet™ Configure. See 
“mySewnet” on page 8.

Send the design to the mySewnet™ Cloud 
Send directly to a mySewnet™ device 

Select the machine or

Change the design name 

computer for sending to

before sending
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Convert
Use mySewnet™ Convert to create a copy of the embroidery in another 
embroidery file format, with a different thread range, or with added trims or 
notes.

Note: mySewnet™ Connect only owners may only convert to .vp3 or .vp4.

Convert an embroidery
■ Control–click an embroidery or embroideries and choose Services > mySewnet™ 

Convert. Select the desired Output File Type and Output Folder and click OK. 
The selected embroideries are converted and saved in the selected folder. 

Note: If an embroidery file already exists with the same name, a message appears.

Convert a Group of Butterfly Embroideries
1 Click the Finder icon  in the Dock to open it.
2 In the Show items pop-up menu, choose Columns view .
3 Browse to /mySewnet/Samples/Finder/Stitch/Animals.
4 In the Show items pop-up menu, choose Icon view . You can now see the .vp4 

embroidery files in the Animals folder as thumbnail pictures.
5 Use Command–click to select all of the butterfly designs.
6 Control–click and in the context menu choose Services > mySewnet™ Convert. The 

Convert dialog opens.
7 In the Output Folder pop-up menu, ensure that the folder is set to /mySewnet/My Designs.
8 Click the Output File Types button. The Export dialog opens.
9 In the File Format pop-up menu, set the file type to Compucon / Singer (.xxx).
10 Click OK, then click OK again in the Convert dialog. Copies of the butterfly embroideries 

will be created in .xxx format.
11 Browse to the folder /mySewnet/My Designs to view the converted files.

Select the embroidery file type for exporting

Choose the export folder for the converted embroidery

Add trims before stop commands and color changes
Use a different thread range in the exported embroidery

Add notes to the embroidery file

Select a thread range
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Output File Type
Click the button to view the Export dialog where you can select an embroidery file 
format for exporting the converted files. See “Export” on page 29.

The preferred file format for exporting embroideries is Husqvarna Viking / Pfaff 
.vp3, as this will preserve thread color information and notes.

You can also export embroideries as Brother/Baby Lock/Bernina PEC (.pec), 
Brother/Baby Lock/Bernina PES (.pes), Compucon/Singer PSW (.xxx), Husqvarna 
(.hus, .shv), Husqvarna Viking /Pfaff (.vp4, .vp3 and .vip), Janome (.jef and .sew), 
Melco Expanded (.exp), Pfaff (.pcs), Tajima (.dst) or Toyota (.10o).

Output Folder
Select the folder where the converted files should be saved. This is initially set to /
mySewnet/My Designs.

VP4/VP3 Options

Add Trim Commands
Use the Add Trim Commands function to add Trim commands before most 
movement stitches in the selected embroideries.

Note: Trim commands are added before movement stitches using the same criteria 
as for mySewnet™ Stitch Editor. If an embroidery with added Trim commands 
does not display as desired, open it in mySewnet™ Stitch Editor and use Insert 
Trim  on the Modify page of the control panel to add individual Trim commands 
as desired.

Change Thread Range
Use ’Change Thread Range to’ to convert the colors in an embroidery to a chosen 
thread range, including a My Thread range. Any selected embroideries are 
converted.

■ Choose a thread range from the Change Thread Range pop-up menu, and click OK 
to change the thread range.

Note: In other mySewnet™ Embroidery Software apps you can use Thread Range 
in the Color Tone dialog to change the thread range for an embroidery without 
adjusting other settings.

Use Change Thread Range to convert embroideries to any of the thread ranges 
available in the mySewnet™ Embroidery Software. For instance, you may convert 
embroideries to a My Thread range, to see which threads to use from your 
personal thread collection.

Add Extra Notes
Click Add Extra Notes to open the Notes dialog. See “Notes” on page 33.

Note: This is only available when converting to .vp4 or .vp3 embroidery file format.
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Export
Save the project in the current window in the desired format according to the 
chosen options to optimize for sewing. The embroidery must fit in the currently 
selected hoop. Use the Design Player to see how the embroidery will be exported 
according to the current Optimize for Sewing Options.

The preferred file format for exporting embroideries is Husqvarna Viking / Pfaff 
.vp3, as this will preserve thread color information and notes.

You can also export embroideries as Brother/Baby Lock/Bernina PEC (.pec), 
Brother/Baby Lock/Bernina PES (.pes), Compucon/Singer PSW (.xxx), Husqvarna 
(.hus, .shv), Husqvarna Viking /Pfaff (.vip), Janome (.jef and .sew), Melco Expanded 
(.exp), Pfaff (.pcs), Tajima (.dst) or Toyota (.10o).

Optimize for Sewing Options
All of these options are initially selected when saving as a .vp4 file, or in any other 
format.

Note: You can customize the Optimize for Sewing Options in mySewnet™ 
Configure.

Combine: Merge the embroideries into a single embroidery during Export. 

Note: Combine is not enabled if there is only one design, and for embroidery 
formats that are automatically combined.

Remove Overlap: Prevent areas of stitches building up where embroideries 
overlap.

Remove Overlap is not available when Combine is not enabled.

Note: Only deselect this option if, for example, your embroideries are low density 
and you wish to have a blend effect where they overlap. Also, some multipart 
embroideries are created with areas that are designed to overlap each other near 
the mid-section of a turnable hoop. When viewing these designs in mySewnet™ 
Embroidery, deselect Remove Overlap before exporting. Deselect Remove 
Overlap in mySewnet™ Configure, Export, before sending them to the 
embroidery machine.

Choose an embroidery format

Optimize the embroidery for 

Go to the "Save" or "Saving as" dialog

Set the options for splitting 

Create placement stitches 

Rotate the hoop to suit your machine

stitching out

for decorations

in a multipart hoop
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ColorSort: Reduce the number of thread colors during Export. 

Optimize Stitch Length: Automatically remove small and insignificant stitches. 
See “Optimize Stitch Length” on page 32.

Note: Cutwork Needle lines in the Inspira Cutwork Needle "thread range" are 
unaffected by Optimize Stitch Length.

Decoration
Create Center or Line placement stitches for Decorations added in mySewnet™ 
Embroidery, or remove all decorations and their associated placement stitches.

Center or Line placement stitches are created automatically for decorations 
according to the options set in mySewnet™ Configure, which may be altered 
when you export the embroidery. Alternatively, create crystal transfer templates 
for automated cutters with Export Decoration Template in mySewnet™ 
Embroidery.

Center placement stitches are recommended when most decorations are 
individual and symmetrical. Line placement stitches are recommended when most 
decorations are individual and asymmetrical (such as bugle beads) or lines of 
closely spaced beads or sequins.

Hoop Orientation
These options are not available from the Finder.

Splitting options
Click the button to open the splitting options dialog. See “Splitting for Multipart 
Hoops” on page 31.

Additional Sections
Additional dialog sections are available, depending on the chosen file format.

• If .vp3 or .vp4 is chosen, Splitting for Multipart Hoops is present. See “Splitting 
for Multipart Hoops” on page 31.

• If .pes is chosen, you can select your machine type, file version, hoop size and 
rotation.

• If .jef is chosen, you can select your machine type, hoop size and rotation.

Next
View the Save, or Saving As dialog, depending on the selected file format.

Export an Embroidery
1 Click the Finder icon  in the Dock to open it.
2 Browse to the desired folder and use Command–click to select the desired embroidery.
3 Control–click and in the context menu choose Services > mySewnet™ Convert. The 

Convert dialog opens.
4 Click the Output File Types button. The Export dialog opens.
5 In the File Format pop-up menu, choose a file type.
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6 Select your optimization options.
7 If you are using a multipart hoop, set Intelligent or Straight Line split.
8 Click OK, then click OK again in the Convert dialog. Copies of the embroidery are created 

in the chosen format.

Splitting for Multipart Hoops
Note: This section appears if .vp4, .vp3 or .pes is selected as the file format.

Embroideries for Multipart hoops are split automatically, according to your Export 
settings. Use an Intelligent or Straight Line Split.

Note: There is no need to ensure embroideries are in one stitch area of the hoop; 
just place your embroideries in the most pleasing arrangement. 

Split Method
You can use one of two split methods:

• Intelligent Split automatically calculates a split line that cuts the minimum 
number of stitches, and minimizes cuts through solid sections of embroidery. 
Where possible, use Intelligent Split.

• Straight Line Split cuts the embroidery straight across the center line of the 
overlap zone.

Intelligent with Tolerance
Intelligent Split calculates a split line that cuts the minimum number of stitches, and 
minimizes cuts through solid sections of embroidery. For example, a large 
embroidery is split at a narrow section, and an embroidery that fits in one stitch 
area of the hoop is left in one piece even if it is part of a larger design.

Tolerance ensures that the Intelligent Split line stays a short distance from the 
edges of the overlap. This allows for play in the hoop when going from one hoop 
area to another, such as when aligning a hoop that has been turned to stitch out 
the other side of an embroidery.

You can set Tolerance from 0 to 3mm, in steps of 1mm. The initial setting is 1mm.

Use Intelligent Split with Tolerance
■ Select the "Intelligent with Tolerance" checkbox, then enter a number in the 

Tolerance number box, or use the arrows to increase or decrease the Tolerance.

Straight with Compensation
Straight Line Split cuts straight across the center of the overlap zone. Straight Line 
Split will only split an individual embroidery if, before it is combined with 
everything else, it does not fit entirely into one stitch area of the hoop.

Note: Lettering is split straight down the middle, as with any other type of 
embroidery. This may cut through characters rather than gaps and spaces. In such 
cases, it is recommended to use Intelligent Split instead.
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Compensation adds overlapping stitches along the edges where the embroidery 
is split. This compensates for pull on the fabric.

Alignment Stitch for Turnable Hoops
Select this option to add an alignment cross at the end of the first embroidery 
section when using the HUSQVARNA VIKING® Designer Majestic™, PFAFF® 
creative Grand Dream™, Universal Multipart hoop or Brother Jumbo Frame 
Hoop. A hoop movement to the alignment cross is added at the beginning of the 
next section. The next embroidery section can then be correctly aligned, or 
alignment can be confirmed.

Optimize Stitch Length
Use Optimize Stitch Length to automatically remove small and insignificant 
stitches.

Stitch Length Sensitivity
Adjust the sensitivity of the optimization. Low is set as the default.

■ Choose Low, Medium or High from the pop-up menu.

Minimum Significant Stitch Length
Select the shortest stitch length that you consider to be significant. Stitches below 
this length are removed during the optimization process. The default stitch length 
is 0.8 mm.

Note: Cutwork Needle lines are unaffected by the Minimum Significant Stitch 
Length.

■ Choose 0.6 mm, 0.8 mm or 1.0 mm from the pop-up menu.

None Use None if you can split an embroidery without cutting through any of the 
design elements. Compensation is initially set to None.

Low Use Low when cutting through a lightly stitched embroidery or when the split 
lines go through only a few stitch areas.

High Use High when the embroidery is dense, when the split lines make long splits 
through stitch areas, or when stitching onto materials such as knitted or 
stretchy fabric.

Adjust the sensitivity
Set your shortest desired stitch length
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Notes
The Notes dialog allows free text and keywords 
to be added to the Notes for the selected 
embroidery. Enter additional Notes in the Notes 
box.

Note: Add a keyword or phrase to all 
embroideries when converting a group.

Up to 2000 characters can be entered in the 
Notes.

Note: If the Notes in any embroidery file is more 
than 2000 characters long after adding the new 
Notes, only the first 2000 characters will be 
retained.

Keywords
Select Keywords for the embroidery from the 
list, then click Add to add them to the Notes for 
the embroidery.

Edit the Notes for an Embroidery
1 Select the embroidery that you want to add notes to.
2 Control–click and in the context menu choose Services > mySewnet™ Convert. The 

Convert dialog opens.
3 Click Add Extra Notes.
4 In the Notes text box make your desired changes to the Notes.

Note: Use Option–Return or Control–Return to start a new line of text.
5 To add Keywords, select the keyword from the Category heading or subcategory in the 

scrolling list. Then click Add to add them to the Notes.
6 Click OK to save your amended Notes and added keywords.

Searching for Embroideries
Use Spotlight to find embroideries by name, and from information in the notes and 
settings. You can also search on other properties, and sort your search results.

Sorting Files in List View
Use the headers at the top of the columns in List  view to sort files. For 
example, click the Name header to place files in alphabetical order, or sort by the 
date of creation or modification.

■ Click a header in List view. The files are sorted using that header. 

Note: To change the headers, Control–click one of the headers and add or remove 
headers from the context menu.
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Search for Embroideries by Name and in the Notes
1 Click the Finder icon  in the Dock to open it.
2 In the Show items pop-up menu, choose Column view .
3 Browse to /mySewnet/Samples/Stitch Editor/Stitch.
4 In the Show items pop-up menu, choose Icon view . You can now see the .vp4 

embroidery files in the Stitch folder as thumbnail pictures.
5 In the Spotlight text box, enter 

the word: flower
6 In Search, click "Stitch" to 

search only the current folder. 
Thirteen items are found.

7 Many of these embroideries 
have "flower" in their name, but 
ButterfliesHoodie.vp4 does not. 
Control–click 
ButterfliesHoodie.vp4 and 
choose Quick Look in the 
context menu.

8 Scroll down in the Quick Look 
window. The word "Flowers" is present in the Notes.
Spotlight searches in the embroidery Notes and Settings, as well as for the file and folder 
name.

9 Close the ButterfliesHoodie Quick Look window.
10 In the Spotlight text box, enter the word ’diamond’. The Raygun2HatBadge embroidery is 

listed.
11 Control–click the Raygun2HatBadge embroidery and choose Quick Look. In the Quick 

Look window, scroll down to the Settings. The Settings includes information on the 
Diamond style used in the Crosshatch fill.
Note: A search may produce unexpected results. Check the Notes and Settings, as well as 
the folder name, to reveal the reason for a surprising result.

12 Close the Raygun2HatBadge Quick Look window.
13 In the Spotlight text box, enter the word ’flower’ again.
14 To the right of the window in the Search bar, click +. A second search bar appears.
15 In the "Kind" pop-up menu, click Other, and in the Search Attribute list choose Embroidery 

Notes, and enter ’flowers’ in the text box.
Several embroideries are found, all of them 
use word flowers in their Notes.
Note: This method of searching looks only at 
the Notes. It can be used to exclude 
unexpected results from the name, settings, or 
folder name. To search for information in the 
Settings, in the Search Attribute list choose 
’Embroidery Settings’ instead of ’Embroidery 
Notes’.

16 Delete the last four letters from ’flowers’ in the second search bar to make ’flo’. Many more 
embroideries are now displayed, as they had ’floral’ in their Notes, not ’flowers’. You can 
search on incomplete words, as well as complete words.
Note: Use Embroidery Notes and Embroidery Settings as well as other properties such as 
Embroidery Stitches to search for embroidery information in Spotlight.
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Search Types
Use the following search types to search for embroidery properties. 

Refining a Search
Use Search to look for files in nested folders, and refine and sort the results to 
view them.

1 Click the Finder icon  in the Dock to open it and use Column view  to browse to /
mySewnet/Samples/Finder/Stitch. The folders within the Stitch folder are displayed.

2 In the Show items pop-up menu, choose Icon view .
3 In the Spotlight text box, enter the word ’flower’, and in Search, click "Stitch" to search only 

the current folder. There are 47 items in the search results.
4 Look at the list of results. It includes the folder Flowers.

Note: The search results include the contents of the folders within the Stitch folder, and the 
names of the folders.

5 To the right of the window, in the Search bar, click +. A second search bar appears.
6 In the pop-up menu on the left, choose Kind.
7 In the pop-up menu on the right, choose Other, and enter "embroidery" in the text box. 

Only embroidery files are now displayed.
Note: If you had performed this search on the whole of your computer, all embroidery files 
on your Mac would be listed.

8 Look at the names of the embroidery files. The flowers use varied embroidery file formats.
9 To the right of the window, in the second Search bar, click +. A third search bar appears.
10 In the pop-up menu on the left, choose 

Name.
11 In the pop-up menu to the right, 

choose "contains".
12 Enter the phrase "vp4" in the text box. 

Only embroideries in .vp4 format are 
now displayed.

13 You can also search for part of a file 
name this way. Enter the word ’magic’. 
Fourteen embroideries in varying 
formats are shown.

Search Term Items Searched

Embroidery Notes Search within the embroidery Notes.

Embroidery Settings Search within the embroidery Settings information.

Embroidery Stitches The number of stitches in the embroidery.

Embroidery Colors The number of thread colors used in the embroidery

Embroidery Width (mm) The width of the embroidery in millimeters.

Embroidery Height (mm) The height of the embroidery in millimeters.

Embroidery Width (") The width of the embroidery in inches.

Embroidery Height (") The height of the embroidery in inches.
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You can refine a search in other ways. To exclude all ’flower’ embroideries with the word 
’metallic’ in their name or notes, do as follows.

14 To the right of the window, click - to 
remove the third search bar.

15 Ensure that the pop-up menu on the 
left is set to Kind, and on the right to 
Other, and ’embroidery’ is entered 
in the text box to display only 
embroidery files.

16 In the Spotlight text box, enter the 
phrase:
flower NOT metallic
None of the 28 files displayed have 
’metallic’ in their name or notes.

Note: The word NOT excludes any file containing the word that follows it. When used in 
this way, NOT must use uppercase letters.

17 Enter the phrase: flower AND metallic
All of the 13 files displayed have both of the words ’flower’ and ’metallic’ in their name or 
notes. AND is a powerful way of narrowing a search.

18 You can also search using the operator OR. This searches for files and folders using either 
the word ’flower’ or the word ’metallic’. Enter the phrase: flower OR metallic

19 To perform advanced searches, you can combine searches. Enter the phrase:
(flower AND metallic) OR (farmyard AND bird)
In addition to the metallic flower embroideries found previously, Goose, Hen and Rooster 
from the Animals folder are also displayed. Place searches within parentheses to combine 
them.

Search Operators
Use the following uppercase search operators when searching:

Search Operator Items Searched

AND Search for items containing both terms.

OR Search for items containing either term.

NOT Search for items that use the first term, but do not use the second.
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Searching for Files by Size and Number of Colors
Use Spotlight to find embroidery files by their size, or the number of stitches.

1 Click the Finder icon  in the Dock to open it and use Column view  to browse to /
mySewnet/Samples/Finder/Stitch. The folders within the Stitch folder are displayed.

2 In the Search text box, enter the word ’farmyard’. Nine items are found.
3 In the Show items pop-up menu, choose List view .
4 At the top of the List view, click the Size header. The search results are sorted by file size.

This is a very quick way to see the approximate size of embroidery files, but using the stitch 
count is a better guide.
Note: If the Size header is not there, Control–click one of the headers and add Size from the 
context menu.

5 In the Show items pop-up menu, choose Icon view .
6 To the right of the window, in the Search 

bar, click +. A second search bar appears.
7 In the pop-up menu on the left, choose 

Other, and in the Search Attributes select 
(check) Embroidery Stitches.

8 Choose Embroidery Stitches in the menu on 
the left.

9 In the pop-up menu to the right, choose 
"equals".

10 In the Embroidery Stitches text box, enter the number ’3433’. The embroidery Hen is 
found.
Embroidery Stitches in this form searches on the exact number of stitches. It would be 
more useful to search within a range.

11 In the pop-up menu to the right, choose "is less than".
12 In the Embroidery Stitches text box, enter the number ’7000’. If you check with Quick 

Look, you will see that all of the embroideries listed contain fewer than 7000 stitches.
13 In the pop-up menu to the right, choose "is greater than".

In the Embroidery Stitches text box, enter the number ’15000’. Only a single embroidery in 
the Stitch folder with more than 15,000 stitches is displayed.

14 As with searching on name and notes, you can combine searches.
15 Set the number back to ’7000’.
16 To the right of the window, in the second Search bar, click +. A third search bar appears.
17 In the pop-up menu on the left, choose Embroidery Stitches.
18 In the pop-up menu to the right, choose "is 

less than".
19 In the lower Embroidery Stitches text box, 

enter the number ’15000’. 
20 If you check with Quick Look, you will see 

that all of the embroideries listed contain 
more than 7000 stitches, but fewer than 
15,000 stitches.

21 Searching on number of colors is very similar. 
Delete the text from the Spotlight text box at 
the top.

22 To the right of the window, click - to remove the third search bar.
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23 In the pop-up menu on the left, choose Other, check Embroidery Colors, then select it in 
the pop-up menu.

24 In the pop-up menu to the right, choose 
"equals".

25 In the Embroidery Colors text box, enter the 
number ’1’.
All embroideries in the Stitch folder using 
only one thread color are displayed.
Note: This is a useful way of searching for 
Redwork embroideries if you did not add the 
term to the Notes.

26 In the pop-up menu to the right, choose "is 
greater than".

27 In the Embroidery Colors text box, enter the number 10. All embroideries in the folder 
with more than ten colors are listed.
Similarly if the menu on the right is set to "is less than", all embroideries with fewer than ten 
colors are shown. If the third search bar is set to Embroidery Colors as well, embroideries 
with a range of number of colors can be shown (for example, more than five, but fewer than 
ten).

Searching for Embroideries by Width, Height and Hoop Size
The methods used when searching for embroideries by width and height are the 
same as those when searching by stitch count and number of colors.

1 Click the Finder icon  in the Dock to open it and use Column view  to browse to /
mySewnet/Samples/Finder/Stitch. The folders within the Stitch folder are displayed.

2 In the Spotlight text box, enter the word ’floral’, and in Search click "Stitch" to search only 
the current folder.

3 To the right of the window, in the Search bar, click +. A second search bar appears.
4 In the pop-up menu on the left, choose Other, and in the Search Attributes select (check) 

Embroidery Width (mm).
5 Choose Embroidery Width (mm) in the menu on the left.
6 In the pop-up menu on the left, 

choose Embroidery Width (mm).
7 In the pop-up menu to the right, 

choose "is less than".
8 In the Embroidery Width text box, 

enter the number: 100
This searches for all embroideries 
in the folder that are narrower 
than 100mm. There are 16 such 
embroideries.

9 In the pop-up menu on the left, 
choose Other, and in the Search 
Attributes select (check) 
Embroidery Height (mm).

10 Choose Embroidery Height (mm) in the menu on the left.
11 In the pop-up menu to the right ensure that "is less than" is selected, and that the number is 

still 100. This time 17 embroideries are found.
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You can combine the two searches to show all embroideries that will fit within a 100mm x 
100mm hoop.

12 In the pop-up menu on the left, choose Embroidery Height (mm), in the pop-up menu to the 
right ensure that "is less than" is selected, and that the number is set to 100.

13 To the right of the window, in the second Search bar, click +. A third search bar appears.
14 In the pop-up menu on the left, choose Embroidery Width (mm).
15 In the pop-up menu to the right, choose "is less than".
16 In the Embroidery Width text box, enter the number: 100. This search displays 16 items. 

Similarly, you could search for any embroideries too big to fit in your largest hoop: 
Set Embroidery Width (mm) to greater than 360, and Embroidery Height (mm) to greater 
than 350.

17 To search for embroideries within a range of hoop sizes, use four search bars. Set one 
Width and Height to your smallest hoop size, for example 100 x 100, and one to your 
largest hoop size, for example 260 x 200.

Universal Hoop Dimensions
These are the Universal hoop dimensions in millimeters for a search to find 
embroideries that will fit within the stated hoop and orientation:

Universal Hoop Size (mm) Search Phrase

Square Hoop 1 100 x 100 Embroidery Width (mm) is less than 100
Embroidery Height (mm) is less than 100

Square Hoop 2 150 x 150 Embroidery Width (mm) is less than 150
Embroidery Height (mm) is less than 150

Square Hoop 3 200 x 200 Embroidery Width (mm) is less than 200
Embroidery Height (mm) is less than 200

Square Hoop 4 120 x 120 Embroidery Width (mm) is less than 120
Embroidery Height (mm) is less than 120

Square Hoop 5 260 x 260 Embroidery Width (mm) is less than 260
Embroidery Height (mm) is less than 260



40          mySewnet™ Configure   Finder Integration & Spotlight 

Midsize Hoop 1
(Vertical)

100 x 170 Embroidery Width (mm) is less than 100
Embroidery Height (mm) is less than 170

Midsize Hoop 1
(Horizontal)

170 x 100 Embroidery Width (mm) is less than 170
Embroidery Height (mm) is less than 100

Large Hoop 1
(Vertical)

130 x 180 Embroidery Width (mm) is less than 130
Embroidery Height (mm) is less than 180

Large Hoop 1
(Horizontal)

180 x 130 Embroidery Width (mm) is less than 180
Embroidery Height (mm) is less than 130

Large Hoop 2
(Vertical)

150x 240 Embroidery Width (mm) is less than 150
Embroidery Height (mm) is less than 240

Large Hoop 2
(Horizontal)

240x 150 Embroidery Width (mm) is less than 240
Embroidery Height (mm) is less than 150

Large Hoop 3
(Vertical)

200 x 260 Embroidery Width (mm) is less than 200
Embroidery Height (mm) is less than 260

Large Hoop 3
(Horizontal)

260 x 200 Embroidery Width (mm) is less than 260
Embroidery Height (mm) is less than 200

Large Hoop 4
(Vertical)

200 x 360 Embroidery Width (mm) is less than 200
Embroidery Height (mm) is less than 360

Large Hoop 4
(Horizontal)

360 x 200 Embroidery Width (mm) is less than 360
Embroidery Height (mm) is less than 200

Large Hoop 5
(Vertical)

260 x 360 Embroidery Width (mm) is less than 260
Embroidery Height (mm) is less than 360

Large Hoop 5
(Horizontal)

360 x 260 Embroidery Width (mm) is less than 360
Embroidery Height (mm) is less than 260

Multipart Hoop 1
(Vertical)

350 x 360 Embroidery Width (mm) is less than 350
Embroidery Height (mm) is less than 360

Multipart Hoop 1
(Horizontal)

360 x 350 Embroidery Width (mm) is less than 360
Embroidery Height (mm) is less than 350
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8Troubleshooting

Error Messages
Send to Embroidery Machine

"System Error. Please close and restart all software."
This message appears if there are issues with the memory handling of your system 
that make communication with your embroidery machine temporarily unavailable. 
Close and restart all apps and try again. If this does not solve the issue, restart 
your computer.

Setting Export Options

"The value ’*mm’ needs to be in the range 1 to 3mm. Please provide a valid 
value."
This message appears if the tolerance value entered in the box on the Export tab is 
below 1mm or above 3mm, or is not a number. Enter a number within the valid 
range.

Setting Appearance Options

"The value ’*mm’ needs to be in the range 5 to 200mm. Please provide a 
valid value."
This message appears if the value entered in the Real Size box on the Appearance 
tab is below 5mm or above 200mm, or is not a number. Enter a number within the 
valid range.

Using Backup and Restore My Settings

"Restoring your settings will overwrite the current settings."
This message is displayed when you click Restore My Settings in the Utilities tab. 
Click OK, or click Cancel to keep your current settings.

Using Reset All Apps

"Reset All Apps: To reset all applications correctly, you must ensure that 
no mySewnet™ apps are open."
This message is displayed if you select Reset All Apps in the Utilities tab while 
other mySewnet™ Embroidery Software apps are running. Click Cancel, or use 
Quit Open mySewnet™ Apps to close all open apps.
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"Application could not be shut down. mySewnet™ XX could not be quit. 
Please shut this app down manually."
This message is displayed if you select Quit Open mySewnet™ Apps in Reset All 
Apps when, for instance, a dialog is open or you have unsaved changes in a 
mySewnet™ Embroidery Software app. Click OK, and then shut the app down 
manually.
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Other Topics
Using mySewnet™ Connect

"I cannot send a design to my embroidery machine."
First, confirm that the mySewnet™ Connect app is running. mySewnet™ Connect 
appears as a machine icon  in the menu bar.

If mySewnet™ Connect is not running, start it.

■ Click the mySewnet™ Connect icon in the Launchpad , or double-click the 
mySewnet™ Connect icon in the Finder .

Second, confirm that the mySewnet™ Connect app is communicating with your 
embroidery machine.

Loading Embroideries from USB Stick

"I exported my embroidery to my USB stick, but I cannot browse to it on 
my embroidery machine."
Your embroidery machine may not be able to read USB sticks with a large 
capacity. Check the manual for your embroidery machine for information on 
limitations on the size of USB stick memory.

"I exported my embroidery to my USB stick, but I cannot find it when I 
browse the stick on my embroidery machine."
You may need to place the embroidery within a particular folder on your USB 
stick. For example, on the Janome MC350E the embroidery files must be placed in 
the EMB5 folder, while for the MC11000 and MC12000 they must be placed in the 
Embf folder.

General Use of Threads

Colors in mySewnet™ Embroidery Software Files
The mySewnet™ Embroidery Software will display threads in a file in the same 
way on any computer where it is installed. That is, the colors used will be the same 
even if they are reproduced slightly differently on different monitors. You can print 
a worksheet to see the colors and color names used in a particular design. This is 
true, even if you do not have all the threads in a design defined in the database on 
your computer. This is because a mySewnet™ Embroidery Software design has 
complete information for each of the threads it uses.

Each thread used in a design will fall into one of the following categories:

• A thread from the Thread Database.
• A thread from the Thread Database that is not on your own Thread Database 

because your database is out of date.
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• A custom thread defined in the file that does not appear in your Threads 
database.

The availability of threads in the Thread Database will only affect parts of the 
mySewnet™ Embroidery Software where you can change colors, as follows:

• Editing apps: mySewnet™ Embroidery and mySewnet™ Stitch Editor
• Design apps: mySewnet™ Digitizing

Below are some situations you may encounter according to the availability of 
thread definitions, as categorized above.

"I have a design from another user that uses threads from the Thread 
Database that I do not have."
Use Check for Updates to install the latest thread database.

"I have a vp4 or vp3 embroidery from another user that uses a custom 
thread definition they designed."
If you attempt to change the color, a message appears to indicate that the thread is 
not found in My Threads, and the nearest My Threads match is selected. Use 
Import Threads from Embroidery in mySewnet™ Thread Cache to import the 
custom threads, or select a replacement thread.

Account and Activation

"How do I change my personal information for my software account?"
In the mySewnet tab of mySewnet™ Configure click Manage my Subscription and 
change your details. This does not change the registration status of your software, 
but it does allow you to change your personal information and/or dealer 
information.

"How do I activate my software on my computer?"
You can activate your software on your computer in the mySewnet tab of 
mySewnet™ Configure.

"How can I move my activation to another computer?"
You can move your activation to another computer. 

1 In the mySewnet page of mySewnet™ Configure click the Deactivate button. A warning 
message is displayed.

2 Click OK to remove the activation from the computer (or Cancel to retain the activation).
You will then be able to install and activate your software on another computer.
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Thread Colors and Embroidery Machines
Thread Colors and the HUSQVARNA VIKING® Designer 
Diamond Royale, Designer Diamond deLuxe, Diamond, Ruby 
deLuxe and Ruby

Thread Color Representation
When mySewnet™ Embroidery Software embroidery files in .vp3 format are 
displayed on the Ultimate Interactive Screen, the thread colors are displayed 
correctly according to the first color in the thread definition (some threads have 
multiple colors in the thread definition). However, the thread type and weight is 
not used. This means the following:

• All thread types are displayed as if they are rayon, so, for example, metallic 
effects will not be seen

• Threads are displayed with the same thread weight, which is approximately 
equivalent to 40 weight

Ultimate Interactive Screen Display of Colors
While the Ultimate Interactive Screen can display the thread colors correctly 
according to their RGB (red, green, blue) values, some colors may still appear 
different than they do on a computer monitor. This is because of the inherent 
differences in the displays themselves. The same colors can even look different on 
two identical monitors if their brightness, contrast and color settings are different.

Thread Names
Thread names from .vp3 embroidery files are shown on the embroidery machine 
as the first four characters of the thread range abbreviation, the thread weight and 
thread number.

No thread range, thread weight or manufacturer's thread number is shown for 
other file types as this information is not present in other file types. The only 
exception is for .vip embroideries, which shows the thread range for each color in 
the embroidery. This applies when opening embroideries on the machine in their 
native format, rather than sending them from the mySewnet™ Embroidery 
Software.

Thread Conversion
Embroideries other than .vp3 are converted to .vp3 when they are sent from the 
mySewnet™ Embroidery Software. When .vip embroideries are converted, the 
equivalent thread ranges are used. For all other embroidery file formats, the 
threads are converted to the nearest matching color from the Import Thread 
Range chosen in mySewnet™ Configure.

It is also possible, however, to open embroideries directly by browsing the 
computer from the machine, and to open embroideries that have been placed on a 
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USB stick. In this case, the embroideries are opened in their original format. The 
thread colors will be displayed in the RGB colors used by the file format. The color 
changes are numbered and no thread range or thread number information is 
shown. The only exception is for .vip embroideries, which show the thread ranges 
for colors in the embroidery. To see the thread numbers in a .vip embroidery, 
send the embroidery from the mySewnet™ Embroidery Software.

Saving Embroideries from the Ultimate Interactive Screen
Embroideries are always saved in Husqvarna Viking / Pfaff .vp3 format from the 
Ultimate Interactive Screen. All embroideries and lettering currently on the screen 
are saved in the .vp3 file. Files can be saved to the embroidery machine memory, a 
connected USB stick or a connected computer.

Errors from Undefined Thread Colors in Embroideries Saved from the 
Ultimate Interactive Screen
When a file that does not have full thread definitions is loaded on the Ultimate 
Interactive Screen and then saved in .vp3 format, each color will be saved with only 
the RGB value (this assumes that colors have not been changed on the Ultimate 
Interactive Screen). If the file is later opened in the mySewnet™ Embroidery 
Software, attempting to change such a thread color will give the message that it is 
undefined and it will be automatically converted to the nearest thread color in the 
Import Thread Range set in mySewnet™ Configure.

Changing Thread Colors to Available Thread Shades
A fixed set of 64 thread shades from the Robison-Anton Rayon 40 range is 
available for changing colors, as follows:

2296 Black 2439 Blue Ribbon

2217 Twilight 2437 Empire Blue

2731 Gull 2527 Soldier Blue

2539 Chrome 2614 Pro Lusty Blue

2297 Snow White 2300 Ice Blue

2335 Ivory 2239 Sky Blue

2298 Taupe 2533 Ozone

2478 Light Cocoa 2577 Wonder Blue

2544 Desert Cactus 2490 Plum Wine

2545 Cypress 2500 New Berry

2221 Willow 2424 Cachet

2241 Palm Leaf 2588 Mid Lilac

2316 Celery 2243 Light Pink

2557 Yellow 2286 Tulip

2264 Chinese Yellow 2287 Mauve

2462 Sunflower 2288 Iris
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If a color in an embroidery is changed to one of these colors, the .vp3 embroidery 
file will contain the full thread definition for that color when the embroidery is 
saved from the Ultimate Interactive Screen. This will be displayed and identified 
correctly if it is loaded into a mySewnet™ Embroidery Software app.

Thread Colors and the HUSQVARNA VIKING® Designer SE

Thread Color Representation
When mySewnet™ Embroidery Software embroidery files in .vp3 format are 
displayed on the Interactive Designer screen, the thread colors are displayed 
correctly according to the first color in the thread definition (some threads have 
multiple colors in the thread definition). However, the thread type and weight is 
not used. This means the following:

• Variegated threads are displayed in the first color in the thread definition
• All thread types are displayed as if they are rayon, so, for example, metallic 

effects will not be seen
• Threads are displayed with the same thread weight, which is approximately 

equivalent to 40 weight

Interactive Designer Screen Display of Colors
While the Interactive Designer screen can display the thread colors correctly 
according to their RGB (red, green, blue) values, some colors may still appear 
different than they do on a computer monitor. This is because of the inherent 
differences in the displays themselves. The same colors can even look different on 
two identical monitors if their brightness, contrast and color settings are different.

2208 Dark Green 2263 Foxy Red

2579 Vibrant Green 2420 Tuxedo Red

2738 Pro Erin 2467 Orangeade

2555 Pastel Green 2253 Flesh Pink

2318 Pale Green 2413 Flesh

2547 Pebblestone 2377 Bisque

2279 Spruce 2237 Carnation

2457 Green Dust 2504 Cherrystone

2607 TH Green 2629 Pro Walnut

2515 Bluestone 2489 Wicker

2518 Indian Ocean Blue 2518 Old Dark Tex Orange

2452 Green Pearl 2289 Rust

2310 Mint Julep 2231 Toast

2313 Sprite 2331 Mustard

2617 Pro Twinkle 2409 Yellow Mist

2309 Teal 2396 Brite Yellow
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Thread Names
Thread names from .vp3 embroidery files are shown on the Designer SE as the 
first four characters of the thread range abbreviation, the thread weight and thread 
number.

No thread range, thread weight or manufacturer's thread number is shown for 
other file types as this information is not present in other file types. The only 
exception is for .vip embroideries, which shows the thread range for each color in 
the embroidery. This applies when opening embroideries on the machine in their 
native format, rather than sending them from the mySewnet™ Embroidery 
Software.

Thread Conversion
Embroideries other than .vp3 are converted to .vp3 when they are sent from the 
mySewnet™ Embroidery Software. When .vip embroideries are converted, the 
equivalent thread ranges are used. For all other embroidery file formats, the 
threads are converted to the nearest matching color from the Import Thread 
Range chosen in mySewnet™ Configure.

It is also possible, however, to open embroideries directly by browsing the 
computer from the machine, and to open embroideries that have been placed on a 
USB stick. In this case, the embroideries are opened in their original format. The 
thread colors will be displayed in the RGB colors used by the file format. The color 
changes are numbered and no thread range or thread number information is 
shown. The only exception is for .vip embroideries, which show the thread ranges 
for colors in the embroidery. To see the thread numbers in a .vip embroidery, 
send the embroidery from the mySewnet™ Embroidery Software.

Saving Embroideries from the Designer SE Interactive Designer Screen
Embroideries are always saved in Husqvarna Viking / Pfaff .vp3 format from the 
Designer SE Interactive Designer screen. All embroideries and lettering currently 
on the screen are saved in the .vp3 file. Files can be saved to the Designer SE 
memory, a connected USB stick or a connected computer.

Errors from Undefined Thread Colors in Embroideries Saved from the 
Interactive Designer Screen
When a file that does not have full thread definitions is loaded on the Interactive 
Designer screen and then saved in .vp3 format, each color will be saved with only 
the RGB value (this assumes that colors have not been changed on the Interactive 
Designer screen). If the file is later opened in the mySewnet™ Embroidery 
Software, attempting to change such a thread color will give the message that it is 
undefined and it will be automatically converted to the nearest thread color in the 
Import Thread Range set in mySewnet™ Configure.



mySewnet™ Configure   Troubleshooting              49

Changing Thread Colors to Available Thread Shades
A fixed set of 64 thread shades from the Sulky Rayon 40 range is available for 
changing colors in the Designer SE, as follows:

If a color in an embroidery is changed to one of these colors, the .vp3 embroidery 
file will contain the full thread definition for that color when the embroidery is 

1005 Black 1042 Blue Ink

1240 Smoky Gray 1293 Deep Nassau Blue

1219 Gray 0572 Blue Ribbon

1327 Dk. Whisper Gray 1226 Dk. Periwinkle

1001 Bright White 1165 Lt. Sky Blue

1082 Ecru 1248 Med. Pastel Blue

1128 Dk. Ecru 1196 Blue

1266 Toast 1096 Dk. Turquoise

1173 Med. Army Green 1554 Purple Passion

1156 Lt. Army Green 1192 Fuchsia

1211 Lt. Khaki 1033 Dk. Orchid

1229 Lt. Putty 1080 Orchid

1063 Pale Yellow-Green 1111 Pastel Orchid

1061 Pale Yellow 1254 Dusty Lavender

1135 Pastel Yellow 1561 Deep Hyacinth

1023 Yellow 1194 Lt. Purple

1079 Emerald Green 1263 Red Jubilee

1278 Bright Green 1037 Lt. Red

1274 Nile Green 1317 Poppy

1100 Lt. Grass Green 1019 Peach

1331 Pale Green 1068 Pink Tint

1104 Pastel Yellow-Green 1064 Pale Peach

1332 Deep Chartreuse 1154 Coral

1177 Avocado 1034 Burgundy

1550 Desert Cactus 1058 Tawny Brown

1551 Ocean Aqua 1056 Med. Tawny Tan

1288 Aqua 0621 Sunset

1560 Marine Aqua 1021 Maple

1045 Lt. Teal 0568 Cinnamon

1204 Pastel Jade 1333 Sunflower Gold

1205 Med. Jade 1065 Orange Yellow

1206 Dark Jade 1185 Golden Yellow
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saved from the Interactive Designer screen. This will be displayed and identified 
correctly if it is loaded into a mySewnet™ Embroidery Software app.

Thread Colors and the PFAFF® creative sensation pro, 
sensation, performance, vision, 4.0 and 2.0

Thread Color Representation
When mySewnet™ Embroidery Software embroidery files in .vp3 format are 
displayed on the High Definition (HD) screen, the thread colors are displayed 
correctly according to the first color in the thread definition (some threads have 
multiple colors in the thread definition). However, the thread type and weight is 
not used. This means the following:

• All thread types are displayed as if they are rayon, so, for example, metallic 
effects will not be seen

• Threads are displayed with the same thread weight, which is approximately 
equivalent to 40 weight

HD Screen Display of Colors
While the HD screen can display the thread colors correctly according to their 
RGB (red, green, blue) values, some colors may still appear different than they do 
on a computer monitor. This is because of the inherent differences in the displays 
themselves. The same colors can even look different on two identical monitors if 
their brightness, contrast and color settings are different.

Thread Names
Thread names from .vp3 embroidery files are shown on the creative vision as the 
first four characters of the thread range abbreviation, the thread weight and thread 
number.

No thread range, thread weight or manufacturer's thread number is shown for 
other file types as this information is not present in other file types. The only 
exception is for .vip embroideries, which shows the thread range for each color in 
the embroidery. This applies when opening embroideries on the machine in their 
native format, rather than sending them from the mySewnet™ Embroidery 
Software.

Thread Conversion
Embroideries other than .vp3 are converted to .vp3 when they are sent from the 
mySewnet™ Embroidery Software. When .vip embroideries are converted, the 
equivalent thread ranges are used. For all other embroidery file formats, the 
threads are converted to the nearest matching color from the Import Thread 
Range chosen in mySewnet™ Configure.

It is also possible, however, to open embroideries directly by browsing the 
computer from some machines, and to open embroideries that have been placed 
on a USB stick. In this case, the embroideries are opened in their original format. 
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The thread colors will be displayed in the RGB colors used by the file format. The 
color changes are numbered and no thread range or thread number information is 
shown. The only exception is for .vip embroideries, which show the thread ranges 
for colors in the embroidery. To see the thread numbers in a .vip embroidery, 
send the embroidery from the mySewnet™ Embroidery Software.

Saving Embroideries from the HD Screen
Embroideries are always saved in Husqvarna Viking / Pfaff .vp3 format from the HD 
screen. All embroideries and lettering currently on the screen are saved in the .vp3 
file. Files can be saved to the creative vision memory, a connected USB stick or a 
connected computer.

Errors from Undefined Thread Colors in Embroideries Saved from the HD 
Screen
When a file that does not have full thread definitions is loaded on the HD screen 
and then saved in .vp3 format, each color will be saved with only the RGB value 
(this assumes that colors have not been changed on the HD screen). If the file is 
later opened in the mySewnet™ Embroidery Software, attempting to change such 
a thread color will give the message that it is undefined and it will be automatically 
converted to the nearest thread color in the Import Thread Range set in 
mySewnet™ Configure.

Changing Thread Colors to Available Thread Shades
A fixed set of 64 thread shades from the Robison-Anton Rayon 40 range is 
available for changing colors, as follows:

2296 Black 2439 Blue Ribbon

2217 Twilight 2437 Empire Blue

2731 Gull 2527 Soldier Blue

2539 Chrome 2614 Pro Lusty Blue

2297 Snow White 2300 Ice Blue

2335 Ivory 2239 Sky Blue

2298 Taupe 2533 Ozone

2478 Light Cocoa 2577 Wonder Blue

2544 Desert Cactus 2490 Plum Wine

2545 Cypress 2500 New Berry

2221 Willow 2424 Cachet

2241 Palm Leaf 2588 Mid Lilac

2316 Celery 2243 Light Pink

2557 Yellow 2286 Tulip

2264 Chinese Yellow 2287 Mauve

2462 Sunflower 2288 Iris
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If a color in an embroidery is changed to one of these colors, the .vp3 embroidery 
file will contain the full thread definition for that color when the embroidery is 
saved from the HD screen. This will be displayed and identified correctly if it is 
loaded into a mySewnet™ Embroidery Software app.

Thread Colors and the Brother .Pes Format
When choosing colors from the Brother Poly Satin 50 thread range a few colors 
will appear different on the machine screen when the file is saved to a .pes format. 
The colors that are affected are shown in the table.

When a design is read back, the RGB values for the thread colors are converted to 
the nearest thread from the Import Thread Range set in mySewnet™ Configure.

2208 Dark Green 2263 Foxy Red

2579 Vibrant Green 2420 Tuxedo Red

2738 Pro Erin 2467 Orangeade

2555 Pastel Green 2253 Flesh Pink

2318 Pale Green 2413 Flesh

2547 Pebblestone 2377 Bisque

2279 Spruce 2237 Carnation

2457 Green Dust 2504 Cherrystone

2607 TH Green 2629 Pro Walnut

2515 Bluestone 2489 Wicker

2518 Indian Ocean Blue 2518 Old Dark Tex Orange

2452 Green Pearl 2289 Rust

2310 Mint Julep 2231 Toast

2313 Sprite 2331 Mustard

2617 Pro Twinkle 2409 Yellow Mist

2309 Teal 2396 Brite Yellow

86 Deep Rose Carmine (807)

620 Magenta Lilac (612) 

205 Yellow Harvest Gold (206)

208 Orange Pumpkin (126)

339 Clay Brown Reddish Brown (337)

405 Blue Electric Blue (420)

613 Violet Royal Purple (869)

607 Wistaria Violet Lilac (612)



mySewnet™ Configure   Index              53

‘Index
A
About .........................................................2
Add Extra Notes to Converted Files .........28
Add Trim Commands ...............................28
Alignment Stitch for Turnable Hoops ........15
AND ........................................................36
Appearance Options .................................10
Apps

Reset All .............................................4

B
Background Color ....................................10
Backup

Backgrounds .......................................5
Embroidery Fonts ...............................5
My Settings .........................................4

Boolean
Search...............................................36

C
Change Thread Range ...............................28
Close ..........................................................2
Color

Background.......................................10
Color Information.....................................24
Combine...................................................13
Compensation ..........................................15
Computer Name ........................................8
Connection.................................................8
Convert ..............................................23, 27
Cutwork Needle Lines........................16, 32

D
Design Information ...................................24
Dock

Add Apps to .......................................6

E
Email address ..............................................8
Embroideries

Sending .............................................17
Error Messages .........................................41
Exit ...........................................................19
Export ................................................12, 29
Extra Notes ..............................................28

F
File Associations

Reset ..................................................6
File Size

Search...............................................36
Files

Sample ................................................2
Finder Integration .....................................20
Finder Plugin Options ...............................22

G
Get Info ....................................................25
Getting Started ...........................................1
Grid Color ...............................................11
Guides

Reference ...........................................1

View and Print PDF.............................1

H
Help............................................................1
Hoop

Splitting.......................................14, 31
Hoop Size

Search...............................................38

I
Import ......................................................12
Import and Export Options.......................12
Import Thread Range ................................12
Information

Readme ..............................................1
Insert Trim Command ..............................28
Integrated Help ...........................................1
Intelligent Split ..........................................14

L
List View...................................................33

M
Minimum Significant Stitch Length .......16, 32
Multipart Hoops

Splitting.......................................14, 31
My Settings .................................................5
mySewnet tab .............................................8
mySewnet™ .............................................17
mySewnet™ account ..................................8
mySewnet™ Connect ...............................17
mySewnet™ Convert ...............................23
mySewnet™ Options................................19
mySewnet™ Print .....................................23
mySewnet™ Send .....................................23

N
Name

Search...............................................34
NOT ........................................................36
Notes .......................................................33

Search...............................................34
Notes and Technical Information ..............24

O
Open ........................................................22
Open With ...................................23, 24, 25
Operators

Search...............................................36
Optimize Stitch Length..................13, 16, 32
OR ...........................................................36
Other Topics ............................................43
Output File Type.......................................28
Output Folder...........................................28

P
Password ....................................................8
PDF Guides.................................................1
Print .........................................................23
Printing

PDF Guides.........................................1



54          mySewnet™ Configure   Index 

Q
Quick Look...............................................24
Quit mySewnet Configure...........................2

R
Readme ......................................................1
Real Size ...................................................11
Reference Guide .........................................1
Register

mySewnet ...........................................8
Remove Overlap .......................................13
Reset All Apps ............................................4
Reset File Associations................................6
Reset your password ..................................8
Restore

My Settings .........................................5
Right-Click Menu ......................................18

S
Sample

Files ....................................................2
Search

Boolean ............................................36
Hoop Size .........................................38
Refine ...............................................35

Search Operators .....................................36
Search Terms............................................35
Send to mySewnet™ ..........................17, 26
Sending Embroideries................................17
Show Measurements In .............................11
Smart Update..............................................5

Software
Update................................................4

Sorting Files ..............................................33
Split

Multipart Hoops .........................14, 31
Spotlight ...................................................20
Start Automatically ...................................19
Start mySewnet Configure ..........................2
Starting mySewnet™ Connect ..................18
Stitch Count

Search...............................................36
Straight Line Split ......................................14

T
Texture ....................................................11
Thread Colors and Embroidery Machines..45
Thread Range............................................28

Import ..............................................12
Tolerance .................................................14
Trim Commands .......................................28
Troubleshooting .......................................41
Turnable Hoops ........................................15

U
Universal Hoop Dimensions......................39
Update........................................................5
Update Your Software ................................4
Utilities .......................................................3

V
Viewing and Printing PDF Guides ................1


	mySewnet™ Configure
	Reference Guide
	Mac®
	Contents
	Welcome to mySewnet™ Configure
	Utilities
	Updating Your Software
	Reset All Apps
	Backup My Settings
	Restore My Settings
	Reset File Associations

	Your mySewnet™ Account
	mySewnet

	Appearance Options
	Import and Export
	Import
	Export

	Sending Embroideries
	Sending via mySewnet™
	mySewnet™ Connect

	Finder Integration & Spotlight
	Finder Plugin Options
	Quick Look
	Get Info
	Send
	Convert
	Searching for Embroideries

	Troubleshooting
	Error Messages
	Other Topics
	Thread Colors and Embroidery Machines

	‘Index


